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Precedents Drafting Aide 

Download and Install Drafting Aide   

Thomson Reuters Precedents have a document automation feature called the Precedents Drafting Aide (the 

Drafting Aide). The Drafting Aide is a Microsoft Word (MS Word) Macro which has been specially created to help 

you draft and fill in form documents with speed and efficiency. 

You only install the Drafting Aide once on your computer and it is available to you every time you use MS Word.  
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Using the Drafting Aide – Trouble-shooting 

Downloading the Drafting Aide 

The first step in installing the Drafting Aide is to download the installation file. 

The instructions for downloading the Drafting Aide are different depending on which Thomson Reuters product you 

are using to access Thomson Reuters Precedents. To view the instructions for your product, click on the applicable 

link below: 

Westlaw NZ 

Checkpoint 

CD-Rom 

Westlaw 

Precedents Drafting Aide – Download instructions 

1. Close any email applications you have open (eg Outlook) 

(Please note: having email applications open during installation may prevent the Drafting Aide from 

installing properly). 
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2. Go to any Precedent in Westlaw NZ and click on the Drafting Aide tab: 

 

3. Click on the link Download and Install Drafting Aide: 

 

 

4. Save the Drafting Aide installation file (Brkprcd4.doc) 

Please follow the instructions for the web browser you are using: 

Internet Explorer 11 Chrome Firefox 
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Internet Explorer 11 

After you click on the link Download and Install Drafting Aide, a dialog box will appear at the bottom of 

the webpage. You will be prompted:  

Do you want to open or save Brkprcd4.doc from westlaw.co.nz? 

 

Click Save. 

By default, the file will save to the Downloads folder. If you click on the dropdown menu next to Save you 

will have the option to Save as, to save the file to another location of your choice. 

 

After saving you will get a message: 

The Brkprcd4.doc download has completed. 

 

You will be given the option to Open, Open folder or View downloads. If you wish to install the Drafting 

Aide now, click on Open to open the Drafting Aide installation file in MS Word. (Alternatively, you may 

click Open folder or View downloads to find the file Brkprcd4.doc where you saved it on your computer or 

network). 

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using 

(click on the applicable link below): 

MS Word 2016 

MS Word 2013 

MS Word 2010 

MS Word 2007 

MS Word 2003 

MS Word 2000 

MS Word 97 

Return to top 
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Chrome 

After you click on the link Download and Install Drafting Aide, a link to the file Brkprcd.doc will display on 

the bottom left corner of the webpage. By default, the file will download to the Downloads folder on your 

computer.  

 

If you wish to install the Drafting Aide now, click on Brkprcd4.doc in the bottom left corner to open MS 

Word and start the installation of the Drafting Aide (or click on Show all downloads in the bottom right 

corner to find the file Brkprcd4.doc in the Downloads folder). 

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using 

(click on the applicable link below): 

MS Word 2016 

MS Word 2013 

MS Word 2010 

MS Word 2007 

MS Word 2003 

MS Word 2000 

MS Word 97 

Return to top 
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Firefox 

After you click on the link Download and Install Drafting Aide, a dialog box will appear: Opening 

Brkprc04.doc. Select Save File and click OK. 

 

By default, the file will save to your Downloads folder. 

After clicking Save File, click on the Downloads icon (the downward arrow) in the top right corner of the 

Firefox window: 

 

Click on Brkprcd4.doc to open MS Word and start installation of the Drafting Aide (or, click on Show All 

Downloads to find Brkprcd4.doc in the Downloads folder). 

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using 

(click on the applicable link below): 

MS Word 2016 

MS Word 2013 

MS Word 2010 

MS Word 2007 

MS Word 2003 

MS Word 2000 

MS Word 97 

Return to top 
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Checkpoint 

Precedents Drafting Aide – Download instructions 

1. Close any email applications you have open (eg Outlook) 

(Please note: having email applications open during installation may prevent the Drafting Aide from 

installing properly). 

2. Go to any Precedent in Checkpoint and click on Drafting Aide in the left sidebar menu: 

 

3. Click on the document link Drafting Aide (in orange text) at the bottom of the left sidebar 

index: 
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4. Click on the link Download and Install Drafting Aide (in orange text): 

 

5. Save the Drafting Aide installation file (Brkprcd4.doc) 

Please follow the instructions for the web browser you are using: 

Internet Explorer 11 Chrome_Checkpoint Firefox_checkpoint 

Internet Explorer 11 

(Instructions are as for Westlaw NZ) 
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Chrome 

After you click on the link Download and Install Drafting Aide, a link to the file Brkprcd.doc will display on 

the bottom left corner of the webpage. By default, the file will download to the Downloads folder.  

 

Click on Brkprcd4.doc in the bottom left corner to open MS Word and start installation of the Drafting Aide 

(or click on Show all downloads in the bottom right corner to find the file Brkprcd4.doc in the Downloads 

folder). 

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using 

(click on the applicable link below): 

MS Word 2016 

MS Word 2013 

MS Word 2010 

MS Word 2007 

MS Word 2003 

MS Word 2000 

MS Word 97 

Return to top 
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Firefox 

After you click on the link Download and Install Drafting Aide, a dialog box will appear: Opening 

Brkprc04.doc. Select Save File and click OK. 

 

By default, the file will save to your Downloads folder. 

After clicking OK, click on the Downloads icon (the downward arrow) in the top right corner of the Firefox 

window: 

 

Click on Brkprcd4.doc to open MS Word and start installation of the Drafting Aide (or, click on Show All 

Downloads to find Brkprcd4.doc in the Downloads folder). 

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using 

(click on the applicable link below): 

 

MS Word 2016 

MS Word 2013 

MS Word 2010 

MS Word 2007 

MS Word 2003 

MS Word 2000 

MS Word 97 

Return to top 
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CD-Rom 

Precedents Drafting Aide – Download instructions 

1. Close any email applications you have open (eg Outlook) 

(Please note: having email applications open during installation may prevent the Drafting Aide from 

installing properly). 

2. Open a Thomson Reuters Precedents product and click on “Install Drafting Aide” 

 

When you click on Install Drafting Aide, MS Word will open. 

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using 

(click on the applicable link below): 

MS Word 2016 

MS Word 2013 

MS Word 2010 

MS Word 2007 

MS Word 2003 

MS Word 2000 

MS Word 97 

Return to top 
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Installing the Drafting Aide into MS Word 

Once you have downloaded the Drafting Aide onto your computer (from Westlaw NZ, Checkpoint, or from CD-

Rom), the final step is to install (or finish installing) the Drafting Aide into MS Word.  

To finish installing the Drafting Aide, follow the instructions for the version of MS Word you are using (click on the 

applicable link below): 

MS Word 2016 

MS Word 2013 

MS Word 2010 

MS Word 2007 

MS Word 2003 

MS Word 2000 

MS Word 97 

Return to top 

MS Word 2016 

1. Ensure any email applications on your computer are closed (eg Outlook) 

(Please note: having email applications open during installation may prevent the Drafting Aide from 

installing properly). 

2. Open the Precedents Drafting Aide installation file Brkprc4.doc (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If you downloaded the file Brkprc4.doc earlier and now wish to install it in MS Word, you will need to find 

Brkprc4.doc in the Downloads folder on your computer (or wherever it is saved if it was saved elsewhere). 

Once you have found the file Brkprc4.doc, double click on it to open it in MS Word. 

3. Enable Content to allow the Drafting Aide to install 

When Brkprcd4.doc opens in MS Word 2016 you may see a security warning as below: 

SECURITY WARNING Macros have been disabled. Enable Content 

 



13 

Click on Enable Content to allow the Drafting Aide to install. 

4. Click OK to copy Brkprcd.dot to the Microsoft Word startup path 

After clicking Enable Content the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the Microsoft Word startup path. 

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time 

you use MS Word). 

5. Click OK and restart MS Word to confirm the Drafting Aide has been installed 

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box 

below: 

 

Click OK and re-start MS Word (if it does not re-start automatically). 

6. After restarting MS Word, click on the Add-ins tab to confirm that the Precedents Drafting Aide 

has been installed successfully: 
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If the Drafting Aide has been successfully installed, you should see the Drafting Aide icon under the Add-

ins Tab. 

 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go 

to Downloading and opening a Precedent below. 

 

Trouble-shooting 

If you encountered any problems installing the Drafting Aide: 

Check the Installation Trouble-shooting guide 

OR 

Contact our Techcare team for assistance: 

Phone 0800 10 60 25 or  

Email TechCare.ANZ@thomsonreuters.com 

Return to top 

MS Word 2013 

1. Ensure any email applications on your computer are closed (eg Outlook) 

(Please note: having email applications open during installation may prevent the Drafting Aide from 

installing properly). 

2. Open the Precedents Drafting Aide installation file (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.  

(By default, Brkprc4.doc will be in the Downloads folder on your computer). 

https://apac.webmail.thomsonreuters.com/owa/redir.aspx?C=ht2rsuEeNCDojTgAMLWzDABSfoxmLKyfau7sWl3gNyv-8ABXkFTUCA..&URL=mailto%3aTechCare.ANZ%40thomsonreuters.com
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3. Enable Content to allow the Drafting Aide to install 

When MS Word 2013 opens, you may get a security warning: 

SECURITY WARNING Macros have been disabled. Enable Content 

 

If so, click Enable Content to allow the Drafting Aide to install. 

4. Copy Brkprcd.dot to the Microsoft Word startup path 

After clicking Enable Content the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the Microsoft Word startup path. 

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time 

you use MS Word). 

5. Click OK to complete installation and restart MS Word 2013 

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box 

below: 
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Click OK and re-start MS Word (if it does not re-start automatically). 

6. Restart MS Word 2013 to confirm the Drafting Aide has been successfully installed 

Go to the ADD-INS tab and look for the Drafting Aide icon as below: 

 

The Drafting Aide icon looks like this: 

 

If the Drafting Aide icon is in the ADD-INS tab then the installation was successful. 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go 

to Downloading and opening a Precedent below. 

 

Trouble-shooting 

If you encountered any problems installing the Drafting Aide, 

check the Installation Trouble-shooting guide 

OR 

contact our Techcare team for assistance: 

Phone 0800 10 60 25 or  

Email TechCare.ANZ@thomsonreuters.com 

Return to top 

MS Word 2010 

1. Ensure any email applications on your computer are closed (eg Outlook) 

(Please note: having email applications open during installation may prevent the Drafting Aide from 

installing properly). 

2. Open the Precedents Drafting Aide installation file (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

https://apac.webmail.thomsonreuters.com/owa/redir.aspx?C=ht2rsuEeNCDojTgAMLWzDABSfoxmLKyfau7sWl3gNyv-8ABXkFTUCA..&URL=mailto%3aTechCare.ANZ%40thomsonreuters.com
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If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.  

(By default, Brkprc4.doc will be in the Downloads folder on your computer). 

3. Enable Editing to allow the Drafting Aide to install 

When MS Word 2010 opens, you may get a security warning: 

Protected View This file originated from an internet location and might be unsafe. Click for more details. Enable editing 

 

If so, click Enable Content to allow the Drafting Aide to install. 

4. Click OK to copy Brkprcd.dot to the Microsoft Word startup path 

After clicking Enable Content the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the Microsoft Word startup path. 

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time 

you use MS Word). 

5. Click OK to complete installation and restart MS Word 2010 

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box 

below: 

 

Click OK and re-start MS Word (if it does not re-start automatically). 
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6. Restart MS Word 2010 to confirm the Drafting Aide has been successfully installed 

Once MS Word 2010 has re-started, go to the Add-ins tab and look for the Drafting Aide icon as below: 

 

The Drafting Aide icon looks like this: 

 

If the Drafting Aide icon is in the Add-ins tab then the installation was successful. 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go 

to Downloading and opening a Precedent below. 

 

Trouble-shooting 

If you encountered any problems installing the Drafting Aide, 

check the Installation Trouble-shooting guide 

OR 

contact our Techcare team for assistance: 

Phone 0800 10 60 25 or  

Email TechCare.ANZ@thomsonreuters.com 

Return to top 

MS Word 2007 

1. Ensure any email applications on your computer are closed (eg Outlook) 

(Please note: having email applications open during installation may prevent the Drafting Aide from 

installing properly). 

2. Open the Precedents Drafting Aide installation file (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.  

https://apac.webmail.thomsonreuters.com/owa/redir.aspx?C=ht2rsuEeNCDojTgAMLWzDABSfoxmLKyfau7sWl3gNyv-8ABXkFTUCA..&URL=mailto%3aTechCare.ANZ%40thomsonreuters.com
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(By default, Brkprc4.doc will be in the Downloads folder on your computer). 

3. Enable the content to allow the Drafting Aide to install 

When MS Word 2007 opens, you may get a security warning: 

SECURITY WARNING Macros have been disabled. Options 

 

If so, click Options. 

The following dialog box will open: 

 

Select Enable this content and click OK. 

4. Click OK to Copy Brkprcd.dot to the Microsoft Word startup path 

After clicking OK to Enable Content the following dialog box will appear: 
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Click OK to copy Brkprcd.dot to the Microsoft Word startup path. 

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time 

you use MS Word). 

5. Click OK to complete installation and restart MS Word 2007 

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box 

below: 

 

Click OK and restart MS Word (if it does not restart automatically). 

6. Restart MS Word 2007 to confirm the Drafting Aide has been successfully installed 

Go to the Add-ins tab and look for the Drafting Aide icon as below: 

 

The Drafting Aide icon looks like this: 

 

If the Drafting Aide icon is in the Add-ins tab then the installation was successful. 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go 

to Downloading and opening a Precedent below. 
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Trouble-shooting 

If you encountered any problems installing the Drafting Aide: 

Check the Installation Trouble-shooting guide 

OR 

Contact our Techcare team for assistance: 

Phone 0800 10 60 25 or  

Email TechCare.ANZ@thomsonreuters.com 

Return to top 

MS Word 2003 

1. Ensure any email applications on your computer are closed (eg Outlook) 

(Please note: having email applications open during installation may prevent the Drafting Aide from 

installing properly). 

2. Open the Precedents Drafting Aide installation file (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.  

(By default, Brkprc4.doc will be in the Downloads folder on your computer). 

3. Click Enable Content to allow the Drafting Aide to install 

When MS Word 2003 opens, you may get a security warning: 

 

If so, click Enable Macros to allow the Drafting Aide to install. 

https://apac.webmail.thomsonreuters.com/owa/redir.aspx?C=ht2rsuEeNCDojTgAMLWzDABSfoxmLKyfau7sWl3gNyv-8ABXkFTUCA..&URL=mailto%3aTechCare.ANZ%40thomsonreuters.com
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4. Click OK to copy Brkprcd.dot to the Microsoft Word startup path 

After clicking Enable Macros the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the Microsoft Word startup path. 

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time 

you use MS Word). 

5. Click OK to complete installation and restart MS Word 2003 

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box 

below: 

 

Click OK and restart MS Word (if it does not restart automatically). 

6. Restart MS Word 2003 to confirm the Drafting Aide has been successfully installed 

Check for the Drafting Aide icon in the Toolbar: 

 

If the Drafting Aide icon is on the Toolbar, then the Drafting Aide has been installed successfully. 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go 

to Downloading and opening a Precedent below.
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Trouble-shooting 

If you encountered any problems installing the Drafting Aide: 

Check the Installation Trouble-shooting guide 

OR 

Contact our Techcare team for assistance: 

Phone 0800 10 60 25 or  

Email TechCare.ANZ@thomsonreuters.com 

Return to top 

MS Word 2000 

1. Ensure any email applications on your computer are closed (eg Outlook) 

(Please note: having email applications open during installation may prevent the Drafting Aide from 

installing properly). 

2. Open the Precedents Drafting Aide installation file (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.  

(By default, Brkprc4.doc will be in the Downloads folder on your computer). 

3. Completing installation 

When MS Word 2000 opens, you will see the words Precedents Drafting Aide. 

 

You may need to change the security settings to allow the Drafting Aide to install.  

Click on the Tools menu at the top of the page, then on Macro and finally Security: 

https://apac.webmail.thomsonreuters.com/owa/redir.aspx?C=ht2rsuEeNCDojTgAMLWzDABSfoxmLKyfau7sWl3gNyv-8ABXkFTUCA..&URL=mailto%3aTechCare.ANZ%40thomsonreuters.com
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When you click on Security, the Security dialog box will open: 

 

Select Low so you are able to install the Drafting Aide and then click OK. 

4. Click OK to copy Brkprcd.dot to the Microsoft Word startup path 

After clicking OK the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the Microsoft Word startup path. 
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(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time 

you use MS Word). 

5. Click OK to complete installation and restart MS Word 2000 

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you should see the dialog box 

below: 

 

Click OK and restart MS Word (if it does not restart automatically). 

6. Restart MS Word 2000 to confirm the Drafting Aide has been successfully installed 

Look for the Drafting Aide icon, as below, in the toolbar: 

 

If the Drafting Aide icon is in the toolbar, then the installation was successful. 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go 

to Downloading and opening a Precedent below. 

Trouble-shooting 

If you encountered any problems installing the Drafting Aide: 

Check the Installation Trouble-shooting guide 

OR 

Contact our Techcare team for assistance: 

Phone 0800 10 60 25 or  

Email TechCare.ANZ@thomsonreuters.com 

Return to top 

https://apac.webmail.thomsonreuters.com/owa/redir.aspx?C=ht2rsuEeNCDojTgAMLWzDABSfoxmLKyfau7sWl3gNyv-8ABXkFTUCA..&URL=mailto%3aTechCare.ANZ%40thomsonreuters.com
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MS Word 97 

1. Ensure any email applications on your computer are closed (eg Outlook) 

(Please note: having email applications open during installation may prevent the Drafting Aide from 

installing properly). 

2. Open the Precedents Drafting Aide installation file (if not already open) 

If you have just followed the instructions for downloading the Drafting Aide, the installation file 

(Brkprc4.doc) should already be open in MS Word. 

If Brkprc4.doc is not already open, locate the file and double click on it to open it in MS Word.  

(By default, Brkprc4.doc will be in the Downloads folder on your computer). 

3. Complete installation 

When MS Word 97 opens, you may get a security warning as you are about to install an MS Word Macro: 

 

Please click Enable Macros (if you click Disable Macros the Drafting Aide will not install). 

4. Click OK to copy Brkprcd.dot to the Microsoft Word startup path 

After clicking Enable Content the following dialog box will appear: 

 

Click OK to copy Brkprcd.dot to the Microsoft Word startup path. 

(Copying Brkprcd.dot to the Microsoft Word startup path, will make the Drafting Aide available every time 

you use MS Word). 
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5. Click OK to complete installation and restart MS Word 97 

After clicking OK to copy Brkprcd.dot to the Microsoft Word startup path, you will see the dialog box 

below: 

 

Click OK and restart MS Word (if it does not restart automatically). 

6. Restart MS Word 97 to confirm the Drafting Aide has been successfully installed 

Check for the Drafting Aide icon as below in the Toolbar: 

 

If the Drafting Aide icon is in the Toolbar then the installation was successful. 

For instructions on how to use the Drafting Aide, go to Using the Drafting Aide below. 

For instructions on how to download a Precedent document from Westlaw NZ, Checkpoint or CD-Rom, go 

to Downloading and opening a Precedent below. 

Trouble-shooting 

If you encountered any problems installing the Drafting Aide: 

Check the Installation Trouble-shooting guide 

OR 

Contact our Techcare team for assistance: 

Phone 0800 10 60 25 or  

Email TechCare.ANZ@thomsonreuters.com 

Return to top 

https://apac.webmail.thomsonreuters.com/owa/redir.aspx?C=ht2rsuEeNCDojTgAMLWzDABSfoxmLKyfau7sWl3gNyv-8ABXkFTUCA..&URL=mailto%3aTechCare.ANZ%40thomsonreuters.com
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Installation Trouble-shooting 

 

For help with trouble-shooting, please contact our  

Techcare service 

Phone 0800 10 60 25 or  

Email TechCare.ANZ@thomsonreuters.com 

 

1. I got to the end of the installation process, but when I restarted MS Word, the Drafting 
Aide icon was not in the Add-ins tab (or in the Toolbar if using MS Word 2003 or below) 

To fix this problem, follow the instructions for your version of MS Word: 

MS Word 2016 and 2013 MS Word 2010 MS Word 2007 MS Word 2003 

 

MS Word 2016 and 2013 

1. Click on the File tab 

2. Click on Options 

 

https://apac.webmail.thomsonreuters.com/owa/redir.aspx?C=ht2rsuEeNCDojTgAMLWzDABSfoxmLKyfau7sWl3gNyv-8ABXkFTUCA..&URL=mailto%3aTechCare.ANZ%40thomsonreuters.com
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3. Click on Add-ins, then select Word Add-ins from the drop-down menu at the bottom of the 

window and click Go  

 

5. Check in the list of Global templates and add-ins for the file name brkprcd.dot: 
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If the checkbox next to the file name brkprcd.dot is not ticked, tick it and click OK. 

(NB: If the checkbox is not ticked, this cause either: 

• the Add-ins tab to not appear; OR 

• the Drafting Aide icon not to appear in the Add ins tab) 

6. Restart MS Word 

After you restart MS Word: 

• The Add-ins tab should appear if it was not there before 

• The Drafting Aide icon should appear in the Add-ins tab 

Return to top 

MS Word 2010 

1. Click on the File tab 

2. Click on Options 

 

3. Follow instructions 3–6 as for MS Word 2016 and 2013 above 
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MS Word 2007 

1. Click on the File tab 

2. Click on Word Options 

 

3. Follow instructions 3–6 as for MS Word 2016 and 2013 above 

MS Word 2003 

1. Click on the Tools tab 

2. Click on Templates and Add-ins in the Tools menu 

3. Follow instructions 3–5 as for MS Word 2016 and 2013 above 

4. Once you have followed these instructions, the Drafting Aide icon should appear in the Toolbar 

2. I got to the end of the installation process, but when I restarted MS Word, there was no 
Add-ins tab (MS Word 2007 and above) 

Follow the instructions as for problem 1 above. 

3. When I try to install the Drafting Aide, MS Word hangs/freezes 

The Drafting Aide has been tested and successfully installed in all versions of MS Word from MS Word 97 

through to MS Word 2016.  

If MS Word freezes or hangs during installation, it is possible there is something in your own IT 

environment that is preventing the Drafting Aide from installing successfully.  
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You may contact Techcare (0800 10 60 25 or email TechCare.ANZ@thomsonreuters.com ) or, your own 

IT support (if you have any) if you need help to trouble-shoot such problems. (Support is also available 

directly from Microsoft; see https://support.office.com/). 

Some things an IT support person should check would be: 

• Was there an email application that was open when the Drafting Aide was being installed? 

• Are the latest MS Word updates installed (there may be an issue that has been resolved in a 

recent update)? 

• Are there incompatible Add-ins installed in the copy of MS Word you are using (if so, it may be 

necessary to disable these before installing the Drafting Aide)? 

• Are there security settings set up by your IT systems administrator (eg which block you from 

installing a macro) that might be preventing the Drafting Aide from installing? 

• Are there any other software/operating system conflicts causing MS Word to freeze/hang (check 

if any other new software has been installed recently that might be causing conflicts, or; check 

Microsoft support forums for any known conflicts: https://support.office.com/)? 

Return to top 

4. Can I install the Drafting Aide on an Apple computer? 

While Thomson Reuters Precedents are not compatible with Apple computers, if the user is running 

Windows emulation software, both the Precedents and the Precedents Drafting Aide should run as normal 

inside the emulated Windows environment. 

Return to top 

Downloading and opening a Precedent 

Please follow the instructions for the Thomson Reuters product you are using: 

Westlaw NZ Checkpoint CD-Rom 

Westlaw NZ 

To download a Precedent, click on the Word document icon: 

  

next to the Precedent Type: 

https://apac.webmail.thomsonreuters.com/owa/redir.aspx?C=ht2rsuEeNCDojTgAMLWzDABSfoxmLKyfau7sWl3gNyv-8ABXkFTUCA..&URL=mailto%3aTechCare.ANZ%40thomsonreuters.com
https://support.office.com/
https://support.office.com/
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Please continue to the instructions for the web browser you are using: 

Internet Explorer 11 Chrome Firefox 

Internet Explorer 11 

After you click on the Word icon, a dialog box will appear at the bottom of the webpage. You will be 

prompted:  

Do you want to open or save Precedent.doc from westlaw.co.nz? 

Click Open if you wish to open the file (and save it later from within MS Word). 

Click Save to save the file first before opening. 

 

By default, the file will save to the Downloads folder. If you click on the dropdown menu next to Save you 

will have the option to Save as, to save the file to another location of your choice. 

 

After saving you will get a message: 

The Precedent.doc download has completed. 

You will be given the option to Open, Open folder or View downloads.  
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Click Open to open the Precedent: 

 

When the Precedent opens, you may get a security warning asking if you wish to enable editing, for 

example: 

 

If so, enable editing (to allow you to use the Precedent). 

Continue to the instructions for Using the Drafting Aide 

Return to top 

Chrome 

After you click on the Word icon, a link to the file Precedent.doc will display on the bottom left corner of 

the webpage. By default, the file will download to the Downloads folder on your computer. 

 

Click on Precedent.doc to open the Precedent. 
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When the Precedent opens, you may get a security warning asking if you wish to enable editing, for 

example: 

 

If so, enable editing (to allow you to use the Precedent 

Continue to the instructions for Using the Drafting Aide 

Return to top 

Firefox 

After you click on Word icon, a dialog box will appear: Opening Precedent.doc. Select Open with Microsoft 

Office Word (default) and click OK to open the Precedent in MS Word (By default, the file will save to your 

Downloads folder): 

 

When the Precedent opens, you may get a security warning, asking if you wish to enable editing, for 

example: 
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If so, enable editing (to allow you to use the Precedent 

Continue to the instructions for Using the Drafting Aide 

Return to top 

Checkpoint 

To download a Precedent, click on the Word document icon: 

 

next to the Tool Type: 

 

To save and open the Precedent, follow the instructions for your browser, as for Westlaw NZ above: 

Internet Explorer 11 Chrome Firefox 
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CD-Rom 

Simply click on Open the document in MS Word 97 or later beneath the Precedent title to open the document in MS 

Word. 

 

Return to top 

Using the Drafting Aide 

For additional help with using the Drafting Aide, our Trainers are there to assist.  

You may request help through the Training website: 

http://training.thomsonreuters.co.nz/ 

The Training website also offers training resources such as videos, User Guides and webinars. 

Launching the Drafting Aide 

After opening a Precedent, launch the Drafting Aide by clicking on the Drafting Aide icon 

 

http://training.thomsonreuters.co.nz/
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You will find the Drafting Aide icon in the Add-ins tab (MS Word 2007-2016) or in the Toolbar (MS Word 2003 and 

below): 

 

When you click on the Drafting Aide icon, the Drafting Aide will open, as below: 

 

 

Drafting Aide version 

The first time you use the Drafting Aide, check the Drafting Aide is the latest version. The current version is v4.02: 
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Variables 

Variables are the bits of information that you fill-in in a form document (such as: [company name], [address], 

etc); they are called “variables” because they vary each time you fill in the form. 

The Drafting Aide will take you through all the variables in a Precedent and allow you to fill in each piece of 

information one-by-one, without you having to type in the document itself; the Precedents Drafting Aide 

automatically inserts whatever you have typed or selected into the correct place(s) in the form.  

Where a variable occurs several times in a document – for example, [respondent’s name] – you only need to type 

that variable once in the Drafting Aide and it will be copied automatically to all the other places in the document 

where it appears. 

Types of variables 

The Thomson Reuters Precedents documents contain the following types of variables: 

1. A request to fill in certain information, for example: 

 

[3=occupation] 

2. A choice variable, requiring you to choose which piece of text from a list you wish to insert, for example: 

 

[6=filing  OR  hearing] 
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3. A choice variable, requiring you to choose which piece of text from a list you wish to insert, part of the 

choice being a request to insert further information, for example: 

 

 

4. An option whether or not to include a piece of text or a clause, for example: 
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5. A suboption (ie, an option that is within another option). For example: 

 

 

6. A choice between two or more sections of the document (these sections can be just a phrase, or several 

clauses in length), where you can only include one of the alternative selections, for example: 
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7. A subchoice (ie, a choice within another choice), for example: 

 

 

The variables appear in blue text in the documents. 

Keyboard navigation in the Drafting Aide 
• TAB: use the TAB key to navigate your way through the available options on the dialog box. 

• ENTER: use the ENTER key to execute the selected button or to insert your typed text. 

• SPACE: use the SPACE key to execute the selected button. 

• CTRL + ENTER: will create a new line when entering text. 

• ARROW keys: use the ARROW keys to navigate between different choices in the variable information 

box. 

• SHORTCUT Keys: each button has it’s own shortcut keys – place your mouse over the button to see the 

keys required or refer to the list below. 

Please note: When using Word 2000 the text in the Precedents Drafting Aide may not be automatically 

highlighted. To overcome this, simply press the TAB key and the text will be automatically highlighted. 

Return to top 

Mouse navigation in the Drafting Aide 

SINGLE Click: using the left mouse button, a single click will execute the required button or place the cursor in the 

input box. 
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Drafting Aide Buttons 

Press the Ctrl key and click on a button below to jump to the explanation for that button: 

        

 

 

YES/OK: (ALT + Y) 

The OK button will replace the highlighted variable with either your text or your selected option or choice. 

 

NO/DELETE VARIABLE: (ALT + D) 

The NO button will remove the highlighted text from the document. Including the preceding space if appropriate. 
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SKIP: (ALT + K) 

The SKIP button will skip the highlighted variable and then locate and highlight the next available variable. 

 

BACK: (ALT + J) 

The BACK button will allow a user to modify a previously completed variable. 

 

LEAVE BLANK: (ALT + B) 

The LEAVE BLANK button will replace the highlighted variable with one of the three available spaces: 2cm, 6cm 

and 12cm. 
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STOP: (ALT + S) 

The STOP button will close the Precedents Drafting Aide. 

 

Document reformat tools: (ALT + T): 

 

This button will present you with a pop-up box with several options. (This box will also pop up automatically when 

there are no more variables to fill, or if you exit out of the Drafting Aide). 

 

The available options are:  

 

1. Import styles from another document – this will allow user to import formatting styles from another 

document. 
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If Import styles from another document? Is selected, when you click the play button at the bottom of the 

dialog box, you will be taken to the documents folder to select a document from which you would like 

styles to be imported. 

Browse to the document you would like to use, select that document and then click Open. The styles from 

that document will then be imported into the Precedent (this may take a few moments). 

 

 

2. Remove editorial notes – this will remove all instances of green italicised editorial notes and any 

external logos or graphics present in the document. 

 

3. Change all text to normal text – this will change the colour of the blue variable text to black and its 

style to non-italic. 

 

4. Renumber paragraphs – allows users to renumber paragraphs/subparagraphs automatically after 

removing or adding paragraphs/subparagraphs.  

The renumbering function can work with several different paragraph label formats (and combinations of 

label formats – ie where several different label formats are used within one document): 

• A., B., C. 

• 1, 2, 3 

• 1.,1.1, 1.11…2., 2.1, 2.11… 

• (i), (ii), (iii) 

• (a), (b), (c) 

Any time you add paragraphs to or remove paragraphs from a Thomson Reuters Precedent, if you use the 

Renumber Paragraphs? function, it will go through the document and renumber/resequence all the 
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paragraph/subparagraph labels that are out of sequence (NB provided any added 

paragraphs/subparagraphs have the same formatting/styling as other items in the same list). 

You may use the renumbering function on a Thomson Reuters Precedent on its own, (for example, if you 

filled in all the variables earlier, but later decide to add new paragraphs/subparagraphs or to remove 

paragraphs/subparagraph - or both). Just: 

• open the document; 

• launch the Drafting Aide; 

• click on the Reformatting Tools button; 

• select the Renumber Paragraphs? option; and 

• click the play button. 

Cross-references: please note, the renumbering function does not currently resequence cross-

references (references within a document to other clauses or paragraphs in the same document) to match 

renumbered paragraphs. If you use the renumbering function, any cross-references that are affected by 

the renumbering will need to be updated manually. 

 

Using the renumbering function on documents that are not Thomson Reuters Precedents: 

Please note, the renumbering function may not necessarily work on documents other than Thomson 

Reuters Precedents. For the renumbering function to work, paragraphs and subparagraphs must be 

formatted/styled in a particular way. Thomson Reuters Precedents are pre-edited so all the paragraphs 

and subparagraphs are already in the correct style to allow the renumbering function to work.  

5. Save the document – this will allow you to save the document at the same time as exiting the Drafting 

Aide. 

HELP: (ALT + H) 

This button will open the Help information. 
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TOGGLE SCROLL OPTIONS:  

This feature will allow you to toggle between scrolling within the Drafting Aide box (the default) and scrolling 

through the document (while the Precedents Drafting Aide continues to run). 

 

Clicking on the dot toggles between the two scroll options. 

Moving the Drafting Aide Dialog Box 

The Dialog Box may be moved from its current position on the screen by holding down the left mouse button on 

the dialog box title bar, labelled Precedents Drafting Aide, and dragging the dialog box to a new position on the 

screen. 

 

Return to top 

 

Document reformat tools 

When all the variables in a Precedent have been filled; or, if the user exits out for the Drafting Aide, the Document 

reformat tools dialog box will open automatically: 
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These tools may also be accessed within the Drafting Aide by pressing the Document Reformat Button: 

 

The instructions for the Document Reformat Tools are outlined under Drafting Aide buttons, above. 

 

Return to top 

Tips/FAQs 

1. What if I’m using the Drafting Aide and I find I don’t have all the information needed to fill 
in a Precedent – can I run the Drafting Aide again later on the same document to enter the 
rest of the information? 

You may partially fill in a Precedent and then re-run the Drafting Aide on it to fill in more information 

later, as many times as you need to. 

If you run the Drafting Aide and skip over some variables, the next time you run the Drafting Aide it will 

take you straight to those variables you did not fill in the last time (it will do this even if previously you 

changed all the variables from blue to black text using the Document Reformatting Tools). 

2. I already used the Drafting Aide to fill in all the variables in a Precedent – now I’ve 
added/removed some paragraphs and I need to renumber the paragraphs again – can I 
use the Drafting Aide just to renumber paragraphs? 

If you run the Drafting Aide on a document where all the variables are already filled in, the Drafting Aide 

will take you straight to the Document Reformatting Tools dialog box: 

 

If you wish to renumber the paragraphs, just tick Renumber paragraphs? and click the play button (there 

is no need to untick the two default options that are already ticked). 

Return to top 
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Using the Drafting Aide – Trouble-shooting 

1. The Drafting Aide is not enabled (Word 2003, Word 2000 and Word 97) 

Sometimes Word decides to disable the Precedents Drafting Aide. In Word, click Help, About, Disabled 

Items. Disabled Items may list the Drafting Aide. You can enable the Precedents Drafting Aide by clicking 

Enable. 

2. Renumbering has not worked properly 

If you use the renumbering function and renumbering does not work as you expected, there may be a 

bug in the document. Please contact one of the Precedents Editors: 

elani.rawson@thomsonreuters.com 

imogen.wybourne@thomsonreuters.com 

3. There seems to be an error in the Precedent 

Please contact the Precedents Editors, (see the previous problem). 

4. Any other problem 

If there is anything else you need help with to do with using the Drafting Aide (or, if you need help with 

any of the issues above) you may contact our Trainers through the Training website: 

http://training.thomsonreuters.co.nz/ 

The Training website also offers training resources such as videos, User Guides and webinars. 

Return to top 
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